WARNING
CAREFULLY READ AND FOLLOW THE INSTRUCTIONS PROVIDED IN THIS DOCUMENT BEFORE OPERATING THE INSTRUMENT.

Notice

Every effort has been made to avoid errors in text and diagrams; however, Tecan Austria GmbH assumes no responsibility for any errors that may appear in this publication.

It is the policy of Tecan Austria GmbH to improve products as new techniques and components become available. Tecan Austria GmbH therefore reserves the right to change specifications at any time with appropriate verification, validation, and approvals.

We would appreciate any comments on this publication.

Manufacturer

Tecan Austria GmbH
Untersbergstraße 1A
A-5082 Grödig/Salzburg
AUSTRIA / EUROPE
T: +43 (0) 6246 8933
F: +43 (0) 6246 72 770
E-mail: office.austria@tecan.com
www.tecan.com

Copyright Information

The contents of this document are the property of Tecan Austria GmbH and are not to be copied, reproduced, or transferred to another person or persons without our prior written permission.

Copyright © Tecan Austria GmbH
All rights reserved.
Printed in Austria.

About the Instructions for Use

This document is intended as a reference and Instructions for Use for the HydroControl software, which is designed for defining and editing programs for the HydroFlex Washer via computer.

This document instructs how to:

- Install the software
- Operate the software

Remark on Screenshots

Data and parameters displayed in screenshots vary depending on the instrument connected. Details and examples are described in the respective Instructions for Use of the instrument connected.

The version number displayed in screenshots may not always be the one of the currently released version. Screenshots are replaced only if content related to application has changed.
Warnings, Cautions and Notes

The following types of notices are used in this publication to highlight important information or to warn the user of a potentially dangerous situation:

- **Note**
  - Gives helpful information.

- **CAUTION**
  - Indicates a possibility of instrument damage or data loss if instructions are not followed.

- **WARNING**
  - Indicates the possibility of severe personal injury, loss of life or equipment damage if the instructions are not followed.

Symbols

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Manufactured by</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Address</td>
<td></td>
</tr>
</tbody>
</table>

# Table of Contents

1. Introduction  
   1.1 Area of Application ...................................................... 1-1  
       1.1.1 HydroControl Intended Use ........................................... 1-1  
   1.2 Specifications .......................................................... 1-1  
       1.2.1 Hardware Requirements ........................................... 1-1  
       1.2.2 System Requirements ............................................. 1-2  
   1.3 Installation .............................................................. 1-2  
       1.3.1 Installing the Program under Windows XP ..................... 1-2  
       1.3.2 Installing the Program under Windows Vista ................. 1-3  
       1.3.3 Connect an Instrument ............................................. 1-5  
       1.3.4 Uninstalling the Program .......................................... 1-6  

2. Starting HydroControl  
   2.1 User Administration Quick Start ..................................... 2-1  
   2.2 Instrument Settings ..................................................... 2-3  
   2.3 Instrument Options ...................................................... 2-5  
       2.3.1 Vacuum Filtration .................................................... 2-5  
       2.3.2 Process Control ....................................................... 2-5  
       2.3.3 Liquid Level Detection (LLD) ..................................... 2-7  

3. General  
   3.1 Program Screen Description .......................................... 3-1  
   3.2 Menu Description ........................................................ 3-2  
   3.3 Toolbar Description ...................................................... 3-4  
   3.4 Status Bar Description .................................................. 3-5  
       3.4.1 Sensor Status ....................................................... 3-5  
   3.5 Creating and Editing Programs ....................................... 3-6  
       3.5.1 Program Strip ....................................................... 3-7  
       3.5.2 Plate Strip ............................................................ 3-8  
       3.5.3 Program Cycles ..................................................... 3-8  
       3.5.4 Aspirate Step ........................................................ 3-9  
       3.5.5 Dispense Step ........................................................ 3-11  
       3.5.6 Wash Step ............................................................. 3-12  
       3.5.7 Soak Step ............................................................... 3-13  
       3.5.8 User Prompt Step ..................................................... 3-13  
       3.5.9 Vacuum Filtration Step .............................................. 3-14  
   3.6 Sample Programs ......................................................... 3-16  
   3.7 Saving a Program ........................................................ 3-19  
   3.8 Importing Programs ..................................................... 3-21  
   3.9 Opening a Program ....................................................... 3-22  
   3.10 Transferring Programs to and from the Instrument .......... 3-23  
       3.10.1 Downloading a Program to the Instrument .................. 3-23  
       3.10.2 Upload Program from the Instrument ......................... 3-24
3.10.3 Locking Programs ............................................................3-25

3.11 Running a Program ...........................................................3-26

3.12 Viewing and Signing Programs .............................................3-28
   3.12.1 Signing Documents ..................................................3-28
   3.12.2 Program Audit Trail ..................................................3-29

3.13 Printing Programs .............................................................3-30
   3.13.1 Print ........................................................................3-30
   3.13.2 Print Preview ...........................................................3-31

3.14 List Management ..............................................................3-33
   3.14.1 Creating and Editing Lists ...........................................3-34
   3.14.2 Saving Lists ..............................................................3-35
   3.14.3 Printing Lists ...........................................................3-36
   3.14.4 Importing Lists .......................................................3-36
   3.14.5 Viewing Lists ..........................................................3-36
   3.14.6 Downloading Lists to the Instrument ............................3-36
   3.14.7 Audit Trail of Lists ....................................................3-37
   3.14.8 Signing Lists ............................................................3-37

3.15 Editing Plate Parameters ...................................................3-38
   3.15.1 Needle Position Diagrams ..........................................3-43
   3.15.2 Saving Plate Parameters .............................................3-44
   3.15.3 Locking Plates .........................................................3-45
   3.15.4 Downloading Plate Definition Files ..............................3-46

3.16 Priming .............................................................................3-47

3.17 Rinsing ............................................................................3-48

3.18 Empty Prime Tray ..............................................................3-49

3.19 User Administration ................................................................3-50
   3.19.1 User Rights ................................................................3-50
   3.19.2 Logging in for the First Time .......................................3-52
   3.19.3 Add/ Modify Group .....................................................3-55
   3.19.4 Add/ Modify User .......................................................3-56
   3.19.5 User Administration Audit Trail ...................................3-57
   3.19.6 User Administration Options .....................................3-58
   3.19.7 User Administration Summary ....................................3-61
   3.19.8 Select Language .......................................................3-61
   3.19.9 Change User .............................................................3-61
   3.19.10 About HydroControl ...............................................3-62

3.20 Exiting HydroControl ..........................................................3-62

Index
1. Introduction

1.1 Area of Application

Note
It is important to note that the proper installation of the instrument and the HydroControl software alone will not ensure compliance with all regional and national laws and requirements. Corresponding policies concerning processes and standard operating procedures, including validation and quality control, must also be established.

1.1.1 HydroControl Intended Use

HydroControl is designed for defining and editing programs, plate parameters, and instrument settings for the HydroFlex Washer via a computer. It is a washer control software for controlling Tecan HydroFlex Washer.

The HydroControl software is designed for general purpose use with a HydroFlex washer according to the software specifications defined in this publication and should only be used by trained personnel.

1.2 Specifications

1.2.1 Hardware Requirements

The following hardware requirements have to be met to use the HydroControl software:

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Pentium PIII 1 GHz</td>
<td>Pentium P4 2 GHz</td>
</tr>
<tr>
<td>Screen Resolution:</td>
<td>1024 x 768</td>
<td>1280 x 1024</td>
</tr>
<tr>
<td>20 GB HDD</td>
<td></td>
<td>40 GB HDD</td>
</tr>
<tr>
<td>256 MB RAM</td>
<td></td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>1 x USB 2.0 or higher</td>
<td></td>
<td>2 x USB 2.0 or higher</td>
</tr>
<tr>
<td>CD ROM Drive</td>
<td></td>
<td>CD ROM Drive</td>
</tr>
<tr>
<td>USB ports</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>
1.2.2 System Requirements

The following system requirements have to be met to use the HydroControl software:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows™</td>
<td>Windows XP Professional (English) Service Pack 1</td>
<td>Windows XP Professional (English) Service Pack 2</td>
</tr>
</tbody>
</table>

The HydroControl software is also compatible with Windows Vista™.

™ Windows is a registered trademark of the Microsoft Corporation.

1.3 Installation

1.3.1 Installing the Program under Windows XP

Caution
It is very important that the person who installs the HydroControl software has System Administrator\(^1\) rights on the computer.

\(^1\) See 3.19 User Administration for differences between User Administrator, Hydro_Administrator and System Administrator.

HydroControl is installed by a software setup program. All of the necessary components are installed automatically.

The software is installed using the following procedure:

1. Start the computer.
2. Insert the Hydro Control CD into the necessary CD drive.
3. An Explorer window will automatically open. The CD is named “TECAN” and “TECAN” will appear as the title of the Explorer window.
4. The setup program is located using the following path:

   D:\Software\HydroControl_Vx_x\Setup_HydroControl.exe, where “D:” is the CD drive that contains the Hydro Control CD and “x_x” is the version number of the HydroControl software.

5. Double-click the Setup_HydroControl.exe file and the installation program is started.
6. A series of dialog boxes will appear, read each one, enter any necessary information and click Next to continue.
7. The files are then installed and the program icon is created.
8. When the Installation Complete dialog box appears, click Finish and the program is ready to be used.
9. Store the Hydro Control CD in a safe place in case the software needs to be reinstalled.
1. Introduction

Previous HydroControl Versions

Any previous HydroControl software versions have to be uninstalled prior installing new software versions. The uninstalling procedure is offered automatically when starting an installation of a new software version.

Once the HydroControl version 2.x has been installed, it is no more possible to install again the version 1.x.

1.3.2 Installing the Program under Windows Vista

When installing the software under Windows Vista, for security reasons, the user has to decide whether to install the software and the device driver software or not.

The following dialogs appear:

Click Continue to install the HydroControl software.

Click Install to continue.
In the right bottom screen corner, the operating system informs you on the progress of installation:

Clicking **Click here for status** and the system displays in detail which driver has been installed. The following window appears:

If **Click here for status** is not clicked, several windows appear with information in fading balloons about the current status of the installation (this screenshot shows the last balloon, confirming successful installation of the software):
1.3.3 Connect an Instrument

Up to four instruments can be connected to the software.

Caution
Install the software before connecting the instrument to the computer.

Connect the instrument to your computer and switch the instrument on. Start the program by selecting Programs/Tecan/HydroControl from the Windows Start menu.

Select Connect from the Instrument menu or click the connect button and the following dialog box appears:

In the Connect to Instrument dialog box select the instrument name. Select Show simulated instruments if no instrument is connected. Select the instrument to be simulated from the drop down list.

Click OK to start HydroControl.
1.3.4 Uninstalling the Program

**CAUTION**

It is very important that the person who uninstalls the HydroControl software has System Administrator rights on the computer.

---

1 See 3.19 User Administration for differences between User Administrator, Hydro_Administrator and System Administrator.

The uninstalling procedure is offered automatically when starting an installation of a new software version. It can also be started from the Windows Start menu: Start/Settings/Control Panel/Add or Remove Programs. Find the HydroControl software in the list of currently installed programs and click **Remove**.

1. The following message will appear asking you if you really want to remove the program. Click **Yes** to continue.

![Add or Remove Programs](image)

2. The following message will appear requesting that you wait until Windows configures the program for removal.

![HydroControl 2.0](image)

3. The following message will appear asking if you would like to remove the user administration from your system. If **Yes** is clicked, all users and passwords will be removed from the system and an administrator will have to be defined at next start up.

![HydroControl Installer](image)

In the following window the system informs you on the remaining time of removal; when no more window appears, the software is uninstalled.
The uninstalling procedure is also offered automatically when starting an installation of a new software version. After clicking setup.exe the following window appears:

Select **Remove** to uninstall HydroControl from your computer.

Click **Next** to continue; the following window appears:
Decide if you want to uninstall the user administration as well. A new user administrator has to be created next time the application is installed.
After your selection the following window appears:

Once all the files have been removed successfully, the following window appears:

Click Finish and the program is uninstalled and no longer listed in the Add or Remove Programs window.
2. Starting HydroControl

Connect the instrument to the computer and switch the instrument ON.
Start the program from the Start menu: Programs/Tecan/HydroControl.

The Connect command from the Instrument menu can be selected only when the Program menu is visible on the instrument's display.

HydroControl can also be used in simulation mode for creating and editing programs when no instrument is available.

2.1 User Administration Quick Start

For a more detailed description, see 3.19 User Administration.

When the HydroControl software is started the first time after installation, a User Administrator password must be defined, (See 3.19.2 Logging in for the First Time for more information). By default the user name for the User Administrator is Admin.

After successfully entering the user administrator password, the user administration database is set up with default user groups and users and the User Administration dialog box appears.

The default user groups are as follows:

- Hydro_Administrator
- Hydro_Application_Specialist
- Hydro_Operator

The default user and membership is as follows:

- Admin
  
  Full name: Administrator
  Initial Password: To be set at first startup

  This is the User Administrator. Do not confuse the User Administrator with the Hydro_Administrator.

The default settings can be changed now (or at any time later, if the logged in user has User Administrator rights). New users and user groups can be added and modified.

Individual groups and users have a name, (Group Name and User Name respectively), which cannot be changed once entered and saved. Users also have a Full Name that can be changed later.

1 See 3.19 User Administration for differences between User Administrator, Hydro_Administrator and System Administrator.
Any user can also be a User Administrator\(^1\), regardless which user group he belongs to, but it is not recommended to give users System Administrator\(^3\) rights!

\(^1\) See 3.19 User Administration for differences between User Administrator, Hydro_Administrator and System Administrator.

**Caution**

If the User Administration password is forgotten, User Administration settings cannot be changed and the HydroControl software must be completely reinstalled.

**Note**

It is recommended that at least two User Administrators are created and that User Administrators be members of a user group with no or minimal application rights.

Rights are assigned to user groups only, not to individual users!

All users that belong to a particular user group have the rights assigned to that user group.

See 3.19.1 User Rights for a table of the User Administrator rights and default User Group rights.

The initial password is valid only once! This means that a user has to change the password at first login. (This does not apply to the User Administrator).

Default options for the user administration are as follows:

- Automatic logout after 15 minutes idle time
- Exit application (and disable user) after 3 unsuccessful logins
- Password must contain at least 5 characters
- Password expires after 90 days
- The initial password given by the User administrator is only valid for 3 days. (Once this time has expired, the User Administrator must reset the password.)

The user administration can be optionally configured to send an email to a specified person (administrator or supervisor) when a user is disabled (because of too many unsuccessful login attempts, see Email Options, page 3-60).

To lock the current application, press the key combination Alt-F12. To continue, the user has to log in again.

For more information see 3.19 User Administration.
2.2 Instrument Settings

The instrument settings can be changed and downloaded to the instrument using the HydroControl software.

Select Settings from the Instrument menu and the following dialog box appears:

The name of the instrument appears in the Name textbox.

In the Show Messages area, select the checkboxes next to the message(s) to be displayed.

In the Security group box, access to the program and settings menus on the instrument can be allowed or denied. Select Program menu access to make Define/Edit in the program menu available on the instrument and select Settings menu access to make the settings menu available on the instrument. This security measure can only be set via the HydroControl software.

Under Setup the number of channels appears.

Set the Bubble Sensor sensitivity to Low, Medium, or High depending on liquids used (if this option is installed). If very foamy liquids are used the bubble sensor should be switched off.

Under LLD switch on or off the liquid level sensors.
Select **Vacuum Filtration – Low or High Vacuum** – to use this option and select the **Unit** of measurement.

Select **Process Control** to use this option and to detect if one or more needles are not or too little dispensing/aspirating liquid or if a non-conductive liquid is being used.

Click **Open Settings** to set the options according to previously saved settings. Click **Save Settings** and enter a name for the file, the extension ‘*.xml’ will automatically be added, then click **OK**.

Once the settings have been defined, click **Update Settings** and the settings will be sent to the instrument.

Click **Keypad acoustics on/off** to adjust the volume of the keypad sounds.
2.3 Instrument Options

Select **Options** from the **Instrument** menu to open the **Instrument Options** dialog box, in which the currently installed options can be viewed.

The following options are available for the HydroFlex Washer:

- Vacuum Filtration
- Magnetic Bead Separation
- Process Control
- Liquid Level Detection

### 2.3.1 Vacuum Filtration

Vacuum filtration step is used when working with special filtration microplates (e.g. PCR-cleanup).

The user can select between low (-50 to -150 mBar) and high (-150 to -850 mBar) vacuum filtration.

### 2.3.2 Process Control

The instrument can detect if one or more needles are not dispensing/aspirating liquid or if a non-conductive liquid is being used.

Process Control only works with the OVERFLOW wash procedure.

The wash buffer forms an electrical connection between the dispensing needles and the aspirating needles. As soon as the wash liquid touches the aspirating needles the electric circuit is closed.

The following errors can be detected using this method:
Dispense Error

An error message appears if some of the needles are dispensing no or too little solution. Possible errors could be a result of blocked dispensing needles, bubbles in the dispensing channels, empty liquid bottles or the dispensing pump is broken.

If no connection between the dispensing needles and the corresponding aspirating needles is made at least 30 µl before the dispensing step is finished, the wash program will be interrupted.

Aspiration Error

In order to prevent the wells from overflowing, the instrument checks when the individual aspiration needles come into contact with the wash solution.

If this happens before 200 µl have been dispensed into the wells the program is stopped immediately and an error message appears. This can occur when the well was not or not completely aspirated, due to a blocked aspirating needle/tube or the general aspiration being too weak.

PC Function Error

Before each wash procedure and each row the program checks whether there is an electrical connection between the dispensing and aspirating needle(s). If a connection exists, the dispense and aspiration errors cannot be detected and the program is interrupted immediately or will not even be started.

The bottom of the manifold must then be cleaned, as the deposits from the wash buffer can produce an electrical connection between the needles, which could prevent the Process control option from functioning correctly.

PC System Error

Process control is not working. Electronics are defective.

Requirements for Process Control

The following conditions are required for the process control to function properly.

- The conductance of the wash buffer must be between 5 mS/cm and 30 mS/cm.
- The wash procedure must be performed in overflow position, so that through the simultaneous dispensing and aspiration a closed circuit is formed and a min. wash volume of 450 µl.
**Conductance of Some Standard Wash Buffers**

Most of the commercial wash buffers lie in the mentioned conductance ranges. The conductance is proportional to the wash buffer concentration.

The following values were measured using a normal dilution:

| Wash buffer Ortho Diagnostic System: | 1:20 - 14.0 mS/cm |
| Wash buffer SIGMA: Phosphate buffered saline tablets: | 1 tablet in 200ml - 14.7 mS/cm |
| Wash buffer bioMérieux: Phosphate buffer concentrate: | 1:25 - 13.7 mS/cm |
| Wash buffer BOUTY: Beta IgM: | 1:20 - 14.2 mS/cm |
| Wash buffer MUREX: Wash fluid (Glycine/Borate): | 1:20 - 7.8 mS/cm |
| Wash buffer BIOTEST ELPHA: (Nr. 3 + 4): | 1:10 - 28.1 mS/cm |

**2.3.3 Liquid Level Detection (LLD)**

Liquid level sensors are built into the covers of all bottles to avoid overflow of waste bottles and to warn the user when the liquid bottles are almost empty.
3. General

3.1 Program Screen Description

The main window of the HydroControl program is divided into three main parts:

- The Control pane on the left, which contains program elements
- The Editor pane in the center contains the current wash program, which contains a program strip, a plate strip, and a cycle strip at start up.
- The Info pane on the right, which contains information about the currently selected strip or errors that exist in the strips and information on how to prevent these errors.

The main window consists of the following items which are described in detail in the subsequent chapters:

- Menu bar
- Tool bar
- Control pane
- Status bar
- Editor pane
- Info pane
### 3.2 Menu Description

The HydroControl program has the following menus:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Menu</strong></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>Define new programs</td>
</tr>
<tr>
<td>Open</td>
<td>Open an existing program</td>
</tr>
<tr>
<td>Save</td>
<td>Save the defined program</td>
</tr>
<tr>
<td>Save As...</td>
<td>Save the defined program under another name. <em>Note: this will create a new audit trail.</em></td>
</tr>
<tr>
<td>Import Program</td>
<td>Import programs</td>
</tr>
<tr>
<td>Print Preview</td>
<td>View the print layout before printing</td>
</tr>
<tr>
<td>Print</td>
<td>Print the current program and program parameters</td>
</tr>
<tr>
<td>Recent Programs</td>
<td>Lists the last 5 programs opened</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the HydroControl software</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>View Menu</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info pane</td>
<td>Show or hide the Info pane</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Show or hide the Toolbar</td>
</tr>
<tr>
<td>Status bar</td>
<td>Show or hide the Status bar</td>
</tr>
<tr>
<td>Audit trail</td>
<td>Opens the Audit Trail dialog box, in which the audit trail can be viewed, printed, and saved.</td>
</tr>
<tr>
<td>Signature</td>
<td>Opens the Signature dialog box, in which the signatures can be viewed and a new signature can be added</td>
</tr>
<tr>
<td>Collapse all</td>
<td>Collapse all strips</td>
</tr>
<tr>
<td>Expand all</td>
<td>Expand all strips</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Instrument Menu</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect</td>
<td>Opens the Connect to Instrument dialog box, in which the instrument can be connected to the computer.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disconnects the instrument from the computer</td>
</tr>
<tr>
<td>Prime</td>
<td>Opens the Prime dialog box, in which the prime parameters can be selected and the prime procedure can be started</td>
</tr>
<tr>
<td>Rinse</td>
<td>Opens the Rinse dialog box, in which the rinse parameters can be selected and the rinse procedure can be started.</td>
</tr>
<tr>
<td>Empty Prime Tray</td>
<td>Empties the prime tray</td>
</tr>
<tr>
<td>Vacuum Filtration</td>
<td>To prepare vacuum to the required level. The program will not be delayed during a run (if this option is installed).</td>
</tr>
<tr>
<td>Settings</td>
<td>Opens the Settings dialog box, in which instrument parameters can be viewed. Settings can be saved, opened, and downloaded to the instrument (update). Instrument Menu security can be defined. Bubble sensor parameters can be set. Reminder messages can be switched on or off. LLD (Liquid Level Detection), Vacuum Filtration and Process Control can be switched on or off.</td>
</tr>
</tbody>
</table>
Options

Opens the Options dialog box, in which the current instrument options can be viewed.

Program / List Menu

Start program from instrument

Opens the Start Program from Instrument dialog box, in which a program can be selected from the Installed Programs list, a plate range can be defined and the program can be started.

Start program from editor

Opens the Select Plate Range dialog box, in which a plate range can be defined and the program currently open in the Editor pane can be started.

Manage Programs

Opens the Manage Programs dialog box, in which the currently installed programs can be viewed. Programs can be saved and downloaded to the instrument, uploaded from the instrument, deleted, or locked.

Manage Lists

Opens the Manage Lists dialog box, in which the currently saved lists can be viewed. Lists can be created, edited, printed, imported, displayed, or downloaded to the instrument. The audit trail of the list can be viewed and signatures can be viewed and new signatures can be added.

Plate Menu

Manage Plates

Opens the Manage Plates dialog box, in which the currently defined plates can be viewed. Plates (plate definition files) can be downloaded to the instrument, uploaded from the instrument, deleted, edited, created, or locked.

Tools Menu

Select Language

Choose the appropriate language for the software and the instrument.

Change User

Change user by entering new user name and password.

User Administration

Users and groups can be added, edited or disabled and user rights can be defined.

Help Menu

Contents

Opens the Contents view of the Help file for the HydroControl software.

Index

Opens the Index function of the Help file for the HydroControl software.

Search

Opens the Search function of the Help file for the HydroControl software.

About

Lists the version numbers of the components of the currently installed HydroControl program.
## 3.3 Toolbar Description

The program has the following toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="" alt="New Program" /></td>
<td>Opens a new program (with no defined steps)</td>
</tr>
<tr>
<td><img src="" alt="Existing Program" /></td>
<td>Opens an existing program</td>
</tr>
<tr>
<td><img src="" alt="Save" /></td>
<td>Saves an existing program</td>
</tr>
<tr>
<td><img src="" alt="Print" /></td>
<td>Prints information about the instrument, software, and the program currently defined in the Editor pane using the default printer. This includes <strong>General</strong> information such as the HydroControl software version number and Instrument Serial Number, <strong>Audit trail</strong> comments, <strong>List of Signatures</strong>, <strong>Program Parameters</strong>, and <strong>Plate Parameters</strong>. See 3.13 Printing for a sample printout.</td>
</tr>
<tr>
<td><img src="" alt="Expand" /></td>
<td>Expands all program strips</td>
</tr>
<tr>
<td><img src="" alt="Collapse" /></td>
<td>Collapses all program strips</td>
</tr>
<tr>
<td><img src="" alt="Connect/Disconnect" /></td>
<td>Connects instrument / Disconnects instrument</td>
</tr>
<tr>
<td><img src="" alt="Start" /></td>
<td>Starts the program currently open in the Editor pane</td>
</tr>
<tr>
<td><img src="" alt="Prime" /></td>
<td>Opens the Prime dialog box</td>
</tr>
<tr>
<td><img src="" alt="Rinse" /></td>
<td>Opens the Rinse dialog box</td>
</tr>
<tr>
<td><img src="" alt="Help" /></td>
<td>Opens the Help file</td>
</tr>
</tbody>
</table>
3.4 Status Bar Description

The status bar provides the **Instrument Name**, **Instrument Serial Number**, **Instrument Mode**, and the **Sensor Status** and the current vacuum pressure.

### 3.4.1 Sensor Status

The sensor status is only active if the LLD option (Liquid Level Detection) or the Vacuum Filtration option is installed and the sensors are activated (see 2.2 Instrument Settings). The “lights” appear gray if the option is not installed.

**LLD Option:**
- **Liquids 1-4**
  - light is green when the bottle is full
  - light is red when the bottle is empty
- **Waste 1 and Vacuum waste**
  - light is green when the bottle is not yet full
  - light is red when the bottle is full

**Vacuum Filtration Option:**
- light is green when vacuum pressure has reached the user-defined level
- light is red when vacuum pressure has not reached the user-defined level
- the current vacuum pressure appears to the right of the light
3.5 Creating and Editing Programs

To define a new program, either click the **New** button or select **New** from the **File** menu. The main window appears as follows:

By default a program strip, plate strip, and a cycle strip appear in the **Editor** pane when a new program is created.

The **Control** pane contains all of the available elements, which can be inserted into a program in the **Editor** pane and is divided in three groups: **Lab Ware**, **Program Items**, and **Options** (See also 3.1 Program Screen Description).
3.5.1 Program Strip

By default a program strip appears in the Editor pane when a new program is created. A program must contain a program strip and only one program strip is allowed per program. The program strip must be the first element in a program.

Enter a Program name in the text field and select the wash mode:

Plate Mode  Each program step is performed on all of the plate strips of a microplate sequentially, before proceeding to the next step. The entire plate is processed for the defined soaking time.

Strip Mode  The entire wash program is performed on one plate strip (8-way manifold) or two consecutive plate strips (16-way manifold) before proceeding to the next plate strip(s). The plate strip(s) is processed for the defined soaking time, before proceeding to the next plate strip(s).

Add Final Aspirate

The final aspirate step is inserted to empty the wells at the end of a wash program. It does not belong to any cycle and is only performed once.

Select the Mode: Normal or Crosswise.

Select the Z-position: Bottom, Overflow or Custom.

Select the Time to determine how long the aspiration needles stay at the bottom position while the reagent is being aspirated, (1 - 20 seconds).

Select the Head speed to determine how fast the needles move into the well, (1 - 20 mm/s).

Select the Aspiration rate (1 - 3).

See 3.5.4 Aspirate Step for detailed information.
3.5.2 Plate Strip

By default a plate strip appears in the Editor pane when a new program is created. A program must contain a plate strip and only one plate strip is allowed per program. The Plate strip must be placed after the Program strip.

Select the plate type from the Plate definition drop-down list. Click the Details button to view the plate parameters of the selected plate type.

See 3.15 Editing Plate Parameters for details about defining custom plate types.

3.5.3 Program Cycles

By default a cycle strip appears in the Editor pane when a new program is created.

To insert a cycle strip, select the cycle icon from the Control pane and drag it to the desired position in the Editor pane and release it. Or double-click the item to place it at the end of the program. The first Cycle strip must be placed after the Plate strip, however more than one cycle strip is allowed in a program.

A cycle consists of a number of program steps that are processed sequentially. The entire cycle can be repeated up to 9 times.

In the Number of cycles text box, select the number of times the cycle is to be repeated (1 - 9 times). Cycles cannot be nested, i.e. a cycle cannot contain another cycle.
3.5.4 **Aspirate Step**

An aspirate step removes liquid from the wells.

To insert an aspirate step, select the aspirate step icon from the Control pane and drag it to the desired position in the program window and release it. Or double-click the item to place it at the end of the program.

Select the aspirating **Mode**: Normal or Crosswise (see Aspirating Mode below for a detailed description).

Select the **Z-position**: Bottom, Overflow or Custom.

**Overflow Position:**
The aspirating needle is positioned slightly above the rim of the well in accordance with the defined plate type (*.pdf file).

**Bottom Position:**
The aspirating needle is set at the deepest position inside the well in accordance with the defined plate type (*.pdf file).

**Custom Position:**
The aspirating needle is positioned at a user-defined distance. When Custom is selected, the dispensing will be performed at this user-defined Z-position. Custom Z-positions cannot be saved in the plate definition (*.pdf file).

In the **Time** area, select how long the aspiration needles stay at the bottom position while the reagent is being aspirated, (1 - 20 seconds).

In the **Head speed** area, select how fast the needles move into the well (1 - 20 mm/s).

Select an **Aspiration rate** from the drop-down list (1 - 3).
3. General

Aspirating Modes

To improve wash efficiency and to reduce the residual volume, the manifold must be positioned so that the aspirating needles are correctly positioned in the wells for round-bottom, v-shaped bottom, or flat-bottom well microplates.

Normal Aspiration Mode

For round-bottom or v-shaped bottom wells, the aspirating needles are placed in the middle of the wells. Only one aspiration position can be selected.

Crosswise Aspiration Mode

With flat bottom wells, the instrument can perform crosswise aspiration. The aspirating needles are set at two positions on the bottom of the wells (front edge and back edge).
3.5.5 Dispense Step

A dispense step fills the wells with liquid.

To insert a dispense step, select the dispense step icon from the Control pane and drag it to the desired position in the program window and release it. Or double-click the item to place it at the end of the program.

Select the Z-position: Bottom, Overflow or Custom.

Overflow Position:
The aspirating needle is positioned slightly above the rim of the well in accordance with the defined plate type (*.pdf file).

Bottom Position:
The aspirating needle is set at the deepest position inside the well in accordance with the defined plate type (*.pdf file).

Custom Position:
The aspirating needle is positioned at a user-defined distance.

When Custom is selected, the dispensing will be performed at this user-defined Z-position. Custom Z-positions cannot be saved in the plate definition (*.pdf file).

If Move is selected, the manifold moves step-wise from the bottom position to the Overflow position during dispensing or to the user-defined Custom Z-position during dispensing.

In the Volume area, select the volume of liquid to be dispensed (50 - 400 µl in steps of 50 µl).

In the Channel area, select which channel is to be used, (1 - 4) depending on the instrument configuration and settings.

Select the Dispense rate: Drip Mode, 200, 250, 300, 400, or 500 µl/s
3.5.6 **Wash Step**

Liquid is dispensed and aspirated simultaneously creating a circular flow with a maximum volume of 3000 µl in one wash step for increased wash efficiency.

To insert a wash step, select the wash step icon from the list of available **Program Items**, drag it to the desired position in the program window and release it. Or double-click the item to place it at the end of the program.

Select the aspirating **Mode**: **Normal** or **Crosswise** (see chapter 3.5.4 Aspirate Step).

Select the **Z-position**: **Bottom**, **Overflow** or **Custom**.

**Overflow Position**:
The aspirating needle is positioned slightly above the rim of the well in accordance with the defined plate type (*.pdf file).

**Bottom Position**:
The aspirating needle is set at the deepest position inside the well in accordance with the defined plate type (*.pdf file).

**Custom Position**:
The aspirating needle is positioned at a user-defined distance.

When **Custom** is selected, the wash step will be performed at this user-defined Z-position. Custom Z-positions cannot be saved in the plate definition (*.pdf file).

If **Move** is selected, the manifold moves step-wise from the bottom position to the **Overflow** position during dispensing or to the user-defined **Custom** Z-position during dispensing. **Move** is recommended for cell wash applications or any applications which must be treated with care.

In the **Volume** area, select the volume of reagent to be dispensed: 50 - 3000 µl in steps of 50 µl.
In the **Channel** area, select which reagent is to be dispensed, (1 - 4) depending on instrument configuration.

In the **Head speed** area select the speed (how fast the needles move down: 1 - 20 mm/s).

Select the **Wash rate**: **Drip Mode**, 200, 250, 300, 400, or 500 µl/s

Select an **Aspiration rate** from the drop-down list (1 - 3).

In the **Aspiration time** area, select how long the aspiration needles stay at the bottom position while the reagent is being aspirated, (1 - 20 seconds).

### 3.5.7 Soak Step

During a soak step the liquid remains in the wells for the set time (with or without shaking).

To insert a soak step, select the soak step ![Soak](image) from the **Control** pane, drag it to the desired position in the program window and release it. Or double-click the item to place it at the end of the program.

![Soak](image)

<table>
<thead>
<tr>
<th>Time</th>
<th>0 min 30 s</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Shake" /></td>
<td><img src="image" alt="Intensity" /> Medium</td>
</tr>
</tbody>
</table>

In the **Time area** enter the required soaking time (0 – 60 min and 0 – 59 seconds).

**Note**

*If the soak time is very short, select strip mode to ensure that the soak time is the same across the plate.*

*If the plate is to be shaken, select **Shake** and the required **Intensity** (Low, Medium, or High).*

### 3.5.8 User Prompt Step

The **User Prompt** program element informs the operator of the instrument at a certain moment to execute a definite action during the workflow. Up to 16 characters can be used.

![User prompt](image)

**Text user prompt**

To continue, the operator of the instrument has to press the **OK** button on the display. Please be aware that the command cannot be executed within the software.
3. General

3.5.9 Vacuum Filtration Step

Vacuum filtration step is used when working with special filtration microplates (e.g. PCR-cleanup). This option requires the Tecan Vacuum Filtration Station.

To perform a high vacuum filtration step observe the following order of actions:

Enable Vacuum Filtration in the settings menu (see chapter 2.2 Instrument Settings). Then select Vacuum Filtration in the instrument menu to prepare the required vacuum pressure (vacuum range: -150 mBar to -850 mBar).

![Vacuum Filtration](image)

Select the appropriate Pressure and click Start to build up the vacuum pressure for vacuum filtration.

**Note**

Prepare Vacuum: the value in the Prepare Vacuum dialog and the value of the vacuum strip should be identical in order to guarantee enough time for filtration.

To insert a vacuum filtration step, select the vacuum filtration step icon from the control pane, drag it to the desired position in the program window and release it. Or double-click the item to place it at the end of the program. When Vacuum Filtration is activated, aspiration cannot be selected.

Select the length of Time the vacuum filtration should be performed: 0-60 min and 0-59 seconds

Select the Vacuum pressure, see 2.2 Instrument Settings for selecting the unit of measurement:

<table>
<thead>
<tr>
<th></th>
<th>High Vacuum</th>
<th>Low Vacuum</th>
</tr>
</thead>
<tbody>
<tr>
<td>mBar, hPA</td>
<td>-150 to -850</td>
<td>-50 to -150</td>
</tr>
<tr>
<td>Torr</td>
<td>-1125 to -637</td>
<td>-37.5 to -112.5</td>
</tr>
<tr>
<td>inHg</td>
<td>-4.4 to -25.1</td>
<td>-1.5 to -4.4</td>
</tr>
</tbody>
</table>

If your instrument is equipped with the Low Vacuum option, no Vacuum Prepare procedure is necessary.

Select Clean to remove droplets from the bottom of the filtration plate and to remove excess liquid from the plate transport during a filtration procedure.
If more than 100 µl are filtrated during a vacuum filtration step, we highly recommend to select the **Clean** command.

**Rinse Vacuum Chamber**

This procedure is used to thoroughly clean the plate carrier after running a wash program that contains a vacuum filtration step.

Select **Vacuum Chamber Rinsing** from the **Instrument** menu to start the vacuum chamber rinsing procedure.

The following dialog box appears:

![Vacuum Chamber Rinsing](image)

Click **Start** and a message appears requesting that the microplate be removed from the chamber:

![HydroControl](image)

Remove the microplate and click **OK** to start the rinsing procedure.
3.6 Sample Programs

The following shows a typical wash procedure for working with cells.

Note
This example should not be used as a standard wash procedure for cells as it is necessary to adjust all settings according to the cell type used.
The following shows a typical wash procedure for an ELISA assay.

### Program

**Program name**: Elisa

- Plate mode
- Strip mode

### Plate

**Plate definition**: [GFSE 96] Greiner 96 Flat Transparent

### Cycle

**Number of cycles**: 3

### Wash

- **Mode**: normal, crosswise
- **Zip position**: Overflow
- **Volume**: 450 μl
- **Head speed**: 10 mm/s
- **Aspiration rate**: 2
- **Channel**: 1
- **Move**: 
- **Wash rate**: 300 μl/s
- **Aspirate time**: 1 s

### Final aspirate

- **Mode**: normal, crosswise
- **Zip position**: Bottom
- **Time**: 4 s
- **Head speed**: 10 mm/s
- **Aspiration rate**: 2

**Note**

*This example should not be used as a standard wash procedure for processing ELISA assays as it is necessary to adjust all settings according to the cell type used.*
The following shows a typical wash procedure for vacuum filtration:

**Note**

This example should not be used as a standard wash procedure for vacuum filtration as it is necessary to adjust all settings according to the cell type used.
3.7 Saving a Program

When all the required steps have been defined, save the program by clicking the **Save** button or by selecting **Save** from the **File** menu.

The **Save Program** dialog box appears:

![Save Program dialog box](image)

Enter the required name for the file in the **Document name** field; the extension ‘*.hcp’ will be added automatically.

For additional security, a password can be entered optionally when saving a program. The password is not mandatory.

Click **OK** and the **Password** dialog box appears again requesting that the password be re-entered. Enter the password again and click **OK**. Password-protected programs will appear after download as shown in the following screenshot in the **Manage Programs** dialog box:
Every time the program is manipulated, e.g. opened, downloaded, saved etc., the password has to be re-entered. Click **Save** and the **Save File** dialog box appears. Enter any **Remarks** or **Audit Trail Comments** in the corresponding text boxes and then click **OK** to save program.

The same name cannot be used more than once:

Once the file has been saved, the following reminder appears:

It is important to download the program to the instrument, so that the program can be started from the instrument display (see 3.11 Running a Program). The program can also be started directly from the Editor without being downloaded.

Click **OK** to return to the main window.
3.8 Importing Programs

Programs can be imported as files to allow the exchange of documents (e.g. send a program via email) between instruments. Programs can only be imported using HydroControl software.

To import a program, select Import Program from the File menu. The Import Program dialog box appears:

After selecting the program file, click Open and the program appears in the Editor pane.

If a program is already open in the Editor pane, a message will appear asking if you would like to save the open program. Save or discard the program by clicking Yes or No.
3. General

3.9 Opening a Program

In the File menu, click **Open...** or on the toolbar, click the **Open** button 📄 to open an existing program. The **Open Program** dialog box appears:

![Open Program Dialog Box](image)

A list of existing files, which includes the **Filename** and any associated **Remarks** for each program, is shown.

Select a program and click **Open**. The selected program will appear in the **Editor pane**. The file name of the opened program is displayed in the **Main window title**.
3.10 Transferring Programs to and from the Instrument

Before starting either of the following procedures, ensure that the instrument is switched on and is connected to the computer using a suitable connection cable.

3.10.1 Downloading a Program to the Instrument

To download the program currently in the Editor pane to the connected washer, select Manage Programs from the Program/List menu. The Manage Programs dialog box appears:

Select a program position in the list of Currently Installed Programs to which you would like to download the program currently open in the Editor pane.

Click the Download icon or the Save and Download icon under Instrument on the left side of the dialog box. The name of the program will appear in the list at the selected position.
3. General

If a program already exists in this position a warning message appears:

![Warning Message]

Click **Yes** to overwrite the program on the instrument.

A message appears confirming the download:

![Confirmation Message]

3.10.2 **Upload Program from the Instrument**

To upload a program from the instrument, select **Manage Programs** from the **Program/List** menu. The **Manage Programs** dialog box appears:

![Manage Programs Dialog]

Select the program to be uploaded from the list of Currently Installed Programs and click the Upload icon under Instrument on the left side of the dialog box. The program will appear in the Editor pane.
3.10.3 **Locking Programs**

For security purposes, a wash program can be locked, so that only users with enough rights can open them.

Select a wash program from the list of **Currently Installed Programs** and click **Lock** to lock the program.

Locked programs will appear as follows in the **Defined Programs** list of the **Manage Programs** dialog box:

For added security, the program can also be password-protected (see 3.7 Saving a Program).
3.11 Running a Program

**Note**
Always perform a priming step before starting a program.

**Caution**
To avoid spills when using strip-well plates, check that the selected number and position of the strip corresponds to the manifold installed on the HydroFlex Washer as well as to the layout of the strip plate to be washed. For details, see the instructions for use for HydroFlex Washer.

**Caution**
Before washing procedures are started, make sure that the microplate position A1 is inserted correctly.

To start a program from the instrument, select *Start Program from the Instrument* from the Program/List menu and the following dialog box appears:

Select the program from the list of **Installed Programs**.

Select the **Plate Range**:

- **Whole Plate**: all strips are selected automatically
- **Strips**: select the group of strips to be processed from the drop-down list (always begins with strip 1 (8-way manifold) or strips 1/2 (16-way manifold))
- **Mask**: select the individual strips to be processed

Click *Start* to start the program. The **Program Status** dialog box appears (see **Program Status**, below).

The selected plate range of the last started program is remembered.
To start a program from the Editor, select **Start Program from the Editor** from the Program/List menu or click the **Start Program from the Editor** button and the following dialog box appears:

![Select plate range](image)

Select the **Plate Range**:

- **Whole Plate**: all strips are selected automatically
- **Strips**: select the group of strips to be processed from the drop-down list (always begins with strip 1 (8-way manifold) or strips 1/2 (16-way manifold))
- **Mask**: select the individual strips to be processed

Click **Start** to start the program. The **Program Status** dialog box appears (see **Program Status**, below).

### Program Status

When **Start** is clicked, the **Program Status** dialog box appears:

![Program Status](image)

The **Start** time and the **Current action** will be shown while the program is running.

To abort the program, click **Stop**. When the program has ended, the **End** time will be shown. Click **Close** to return to the main window.
3. General

3.12 Viewing and Signing Programs

To view the signatures or to add a signature to the program currently open in the Editor pane, select Signature from the View menu. The following dialog box appears:

A list of all signatures is displayed.

3.12.1 Signing Documents

Select Add signature to sign the program and the following dialog box appears:

The name of the program is displayed in the Document Name group box.

In the Meaning group box, the following options are available for the Meaning of the signature.

- **Review**: Can be used as part of a release process; program or program list has been checked for errors and is ready for approval.
- **Approval**: Can be used as part of a release process; program or program list has been tested and is approved for use. The approval signature can only be applied if a review signature has already been applied to the record. The Review signature and the Approval signature cannot be signed by the same user.
Any necessary comments can be added in the Comment text box.

In the User Information group box, the user name of the currently logged in user is displayed. In the Password text field, the password of the currently logged in user must be entered to complete the signing procedure.

Click OK to confirm the entries and sign the document.

*Note*

Depending on the standard operating procedures of the company using this software, this signature may be viewed as legally binding, therefore it is very important that the users keep the passwords secret.

### 3.12.2 Program Audit Trail

To view the audit trail of the program currently open in the Editor pane, select Audit Trail... from the View menu.

Whenever a file is created or changed, a record of this action is saved in the Audit Trail. Traceability of changes is provided in connection to the user name (User Full Name).

All modifications to the document are shown and listed according to its version number. Each audit trail entry contains the Version number, User Full Name, User ID, Date of modification, Action (created, modified, or signed) and the audit trail Comment (if entered).

Click Print version to view a report of all relevant data for the audit trail.

Click Save as to open the Save Program dialog box, (see 3.7 Saving a Program). A previous version of the program currently open in the Editor pane can be saved using a different file name. A new audit trail will be created for this program.
3.13 Printing Programs

3.13.1 Print

To print the parameters of the active program, click the Print button or select Print from the File menu. The program parameters will be printed according to the settings made in the Print dialog box. The Windows Print dialog box appears:

Adjust the settings as desired and click Print.
3.13.2 **Print Preview**

To check the document before printing, select **Print Preview** from the **File** menu to display the **Report** window:
Print Preview Toolbar

The Report window has the following toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Print button]</td>
<td>By clicking the Print button, the Windows™ Print dialog box appears. Adjust the settings as desired and click Print.</td>
</tr>
<tr>
<td>![View first page]</td>
<td>View the first page of the report.</td>
</tr>
<tr>
<td>![View previous page]</td>
<td>View the previous page of the report.</td>
</tr>
<tr>
<td>![View next page]</td>
<td>View the next page of the report.</td>
</tr>
<tr>
<td>![View last page]</td>
<td>View the last page of the report.</td>
</tr>
<tr>
<td>![Go to page button]</td>
<td>By clicking the Go to page button, the Go to Page dialog box appears: Enter the number of the page to be viewed and click OK.</td>
</tr>
<tr>
<td>![Zoom button]</td>
<td>By clicking the arrow of the Zoom button, the Zoom menu drops down: Select Page Width, Whole Page, one of the displayed zoom percentages or click Customize... to open the Zooming dialog box in which a custom zoom percentage can be entered.</td>
</tr>
</tbody>
</table>
3.14 List Management

Select **Manage Lists** from the **Program/List** menu and the following window appears:

A list is a group of up to 20 wash programs and 20 plates, which can all be downloaded to the instrument at the same time.

Defined lists, including the *Filename* and any associated *Remarks* for each list, are displayed.
3. General

3.14.1 Creating and Editing Lists

To define a new list of programs or to edit an existing list of programs, select Manage Lists from the Program/List menu and the Manage Lists window appears (see 3.14 List Management above).

Click Create new list to make a new list, or click Edit list to modify an existing list and the following dialog box appears:

A list can contain up to 20 programs.

By pressing the Add program to list button in the middle of the window, selected program(s) are transferred from the left window (programs currently installed on the instrument) to the right window (programs in the list).

Alternatively, press the Add all programs to list button to transfer all available programs to the list. Empty positions in the Currently Installed Programs (left) window will not overwrite occupied positions in the Programs in List (right) window.

Use the Remove program from list button to delete selected programs from the list (left window only). This will NOT delete any programs from the instrument!

Use the Add saved program to list button to import a list of programs.
Use the **Move program up** and **Move program down** buttons to the right of the right window to move the position of the selected program up or down in the list.

When a list is downloaded to the instrument and it contains empty program positions, the corresponding programs on the washer are not deleted! (i.e. If a list contains only programs on storage places 1 and 3, all other programs in positions 2 and 4 through 20 on the instrument will not be overwritten when the list is downloaded).

To link programs to plates, switch between the tabs **Washer Programs** and **Washer Plates**.

### 3.14.2 Saving Lists

When the list of programs is complete, it can be saved by clicking **Save** or click **Save as** to save a modified list under a different name. The **Save List** dialog box appears:

![Save List Dialog Box]

Enter a **Document name** and click **Save**. The extension *.hcl will automatically added to the file name. The **Save File** dialog box appears:

![Save File Dialog Box]

Enter any **Remarks** or **Audit Trail Comments** in the corresponding text boxes and then click **OK** to save the list.
3.14.3 Printing Lists

Click Print list to open the Report window, in which the printout can be viewed before printing. See 3.13.2 Print Preview for a detailed description of the Report window.

3.14.4 Importing Lists

Previously defined lists can be opened from file to allow the exchange of documents (e.g. send a list via email) between instruments. Lists can only be imported using the HydroControl software. Click Import list to open the Import List dialog box in which a list file (*.hcl) can be browsed for and opened.

3.14.5 Viewing Lists

Click Show list opens the Manage List Programs dialog box, in which the selected list can be viewed, but not modified.

3.14.6 Downloading Lists to the Instrument

Click Download list from Manage Lists dialog box to download a list of programs to instrument.

A warning will appear if program positions in the list are already occupied on the washer:

Click Yes to replace the programs.

A reminder appears, which lists plate types required by the programs, but are not installed:

Click Yes and the Manage Plates dialog box opens, in which the required plate types can be selected for downloading.

A message appears, which confirms the successful download of the list to the washer: “List of programs successfully downloaded”. Click OK to return to the main window.
3.14.7 Audit Trail of Lists

Click Audit trail to view the audit trail of the list. The following dialog box appears:

Click Print version to open the Report window, in which the printout can be viewed before printing. See 3.13.2 Print Preview for a detailed description of the Report window.

Click Save as to save a previous version of the selected list using a different file name. A new audit trail will be created for this list.

3.14.8 Signing Lists

Click Signature to sign the selected list. See 3.12.1 Signing Documents for a detailed description of signing documents.
3.15 Editing Plate Parameters

The HydroControl software contains the parameters of many commonly used microplates. Some of the parameters of these plates can be modified to adapt them to specific needs or a completely new set of parameters can be defined for microplates that are not available in the software.

The instrument can store up to 20 plate definitions, making it easy to run programs which require various types of microplates or the same microplate type with different parameters depending on the tests performed.

WARNING
ADJUSTMENT OF HYDROFLEX WASHER TO A CORRESPONDING MICROPLATE:
TO ENSURE PROPER WASH PERFORMANCE IT IS MANDATORY TO ADJUST THE HYDROFLEX WASHER TO THE TYPE / MANUFACTURER OF MICROPLATE OR STRIP-PLATE USED.
THIS ALSO APPLIES FOR ANY PRE-DEFINED PLATE FILE, THAT WILL ALWAYS CONTAIN AVERAGE PLATE PARAMETERS ONLY, THAT HAVE TO BE VERIFIED WITH THE CORRESPONDING PLATE TYPE AND IF NECESSARY CORRECTED BEFORE PUTTING THE HYDROFLEX WASHER INTO USE.
IF THIS ADJUSTMENT PROCEDURE IS NOT PERFORMED PROPERLY, THIS MIGHT RESULT IN HIGH LEVELS OF RESIDUAL VOLUME LEFT PER WELL, AS WELL AS IN INSUFFICIENT WASHING OF THE WELLS AND MAY SERIOUSLY AFFECT ASSAY PERFORMANCE.
FOR DETAILS ON HOW TO ADJUST THE HYDROFLEX WASHER TO THE TYPE OF MICROPLATE OR STRIP-PLATE USED, SEE THE INSTRUCTIONS FOR USE FOR THE HYDROFLEX PLATFORM.

Select Manage Plates from the Plates menu and the following dialog box appears:

To adjust the parameters of an existing plate type, select the plate from the list of Defined Plates or to define parameters for a new microplate type, select an empty position in the list of Defined Plates and click Edit.
The **Edit Plate Definition** dialog box appears:

![Edit Plate Definition dialog box](image)

Select **Choose a plate file** to modify the parameters of an already defined microplate or select **Create a new plate file** to define parameters for a new microplate type.

**General Tab**

For new microplates, it is possible to define the **Description** parameters for the plate on the **General** tab: **Manufacturer**, **Color**, **Material**, and a **Comment** can be added for easy identification.

**Note**

*For the HydroFlex Washer, do not change the number of rows and columns (8 rows, 12 columns).*
Plate Geometry Tab

When defining new plate types, enter parameters as shown below.

The plate geometry can be defined according to **Size** and **Height**.

**Plate Size Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Enter the length of the microplate in µm (including the skirt)</td>
</tr>
<tr>
<td>Width</td>
<td>Enter the width of the microplate in µm (including the skirt)</td>
</tr>
<tr>
<td>Left well position</td>
<td>X-value of A1 distance to middle of well</td>
</tr>
<tr>
<td>Right well position</td>
<td>X-value of H12 distance to middle of well</td>
</tr>
<tr>
<td>Upper well position</td>
<td>Y-value of A1 distance to middle of well</td>
</tr>
<tr>
<td>Lower well position</td>
<td>Y-value of H12 distance to middle of well</td>
</tr>
</tbody>
</table>

**Plate Height Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate height</td>
<td>Enter the height of the microplate in µm (including the skirt)</td>
</tr>
<tr>
<td>Height tolerance</td>
<td>Enter the tolerance of the height measurement distance from upper surface of plate</td>
</tr>
<tr>
<td>Height with cover</td>
<td>Enter the height, in µm, of the microplate with a cover on (including the skirt)</td>
</tr>
<tr>
<td>Skirt height</td>
<td>Enter the skirt height</td>
</tr>
</tbody>
</table>
Well Geometry Tab

When defining new plate types, enter parameters as shown below.

On the **Well Geometry** tab, the form and size of the wells can be defined:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well form top</td>
<td>Select the shape of the top of the wells: Rectangle, Round, Square, or Unknown.</td>
</tr>
<tr>
<td>Well diameter</td>
<td>Enter the Length and Width of the wells for rectangular and square wells or the Diameter for round wells (in µm).</td>
</tr>
<tr>
<td>Well depth</td>
<td>Enter the depth of the wells in µl.</td>
</tr>
<tr>
<td>Bottom form</td>
<td>Select the shape of the bottom of the wells: Flat, Round, V-shaped, or Unknown.</td>
</tr>
<tr>
<td>Working volume</td>
<td>Enter the working volume of the wells in µl.</td>
</tr>
<tr>
<td>Max volume</td>
<td>Enter the maximum volume of the wells in µl.</td>
</tr>
</tbody>
</table>

**Note**

*Information about the well and plate geometry is available from the manufacturer.*
Plate Parameters Tab

When defining new plate types, enter the default values of the Greiner 96-well flat-bottom transparent microplate, if any values are set to zero.

On the Plate Parameters tab, the aspiration offsets, dispensing offset, and Z-positions can be defined.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspirate Y Offset 1</td>
<td>The position of the aspiration needles in which aspiration is started</td>
</tr>
<tr>
<td>Aspirate Y Offset 2</td>
<td>The position of the aspiration needles in which aspiration is finished (Only selectable for 96-well flat-bottom plates)</td>
</tr>
<tr>
<td>Dispense Y Offset</td>
<td>The position of the dispensing needles in which dispensing occurs (restricted by length of aspirating needles)</td>
</tr>
<tr>
<td>Z Position Bottom</td>
<td>The position of the aspiration needles in which bottom washing occurs</td>
</tr>
<tr>
<td>Z Position Overflow</td>
<td>The position of the aspiration needles in which overflow washing occurs</td>
</tr>
</tbody>
</table>

Click **Adjust** and the wash head moves to the defined position.

Select whether these positions will be determined according to the **First strip** or **Last strip**.
Note
Adjust parameters of a filter plate used for vacuum filtration only when vacuum filtration is enabled in the settings menu of the instrument.

Note
Make sure that the vacuum transport is mounted when the vacuum filtration option is enabled.

3.15.1 Needle Position Diagrams

Define wash positions as shown in the diagrams below.

Aspiration Positions

Aspirate Y Offset Positions

Dispense Position

Dispense Y Offset Position

Z-Positions

Z-Positions
3.15.2 **Saving Plate Parameters**

Click **Save as** and enter a name for the newly defined plate parameters. Give the plate definition file a descriptive name (e.g. "Greiner1"). The extension *.pdx will automatically be added to the file name.

The plate parameters can now be used when defining a program, by selecting the necessary plate type from the **Plate definition** drop-down list of the **Plate strip**, (see Plate Strip, page 3-8 for more information).
3.15.3 Locking Plates

For security purposes, plates can be locked.

Select a plate from the list of Defined Plates and click Lock to password-protect the plate definition file.

The Password dialog box appears:

Regular Security

For regular security, do not enter a password and click OK. Only users with enough rights can open plates locked in this way. Locked plates will appear as follows in the Defined Plates list of the Manage Plates dialog box:

High Security

For higher security, enter a password and click OK and the Password dialog box appears again requesting that the password be reentered. Enter the password again and click OK. Password-protected plates will appear as follows in the Defined Plates list of the Manage Plates dialog box:
3. General

3.15.4 Downloading Plate Definition Files

To download plate definition files to the instrument, select Manage Plates from the Plate menu and the following dialog box appears:

Select an empty position or choose to overwrite a filled position and click Download. The following dialog box appears:

Select a plate from the drop-down list and click OK. The plate definition file will be downloaded to the instrument and the following message appears to confirm the successful download.
3.16 Priming

WARNING
BEFORE THE INSTRUMENT CAN BE USED, ALL DISPENSING CHANNELS NEEDED FOR THE WASH STEP MUST BE PRIMED TO FILL THE DISPENSE SYSTEM WITH THE REQUIRED LIQUID.

IF THE PRIMING PROCEDURE IS NOT PROPERLY PERFORMED, THIS MAY RESULT IN INSUFFICIENT WASHING OF THE WELLS AND MAY SERIOUSLY AFFECT ASSAY PERFORMANCE.

ENSURE THAT THE BOTTLE OF PRIMING SOLUTION IS ALWAYS FULL AT THE BEGINNING OF THE PRIMING PROCEDURE AND CHECK THAT THE INLET FILTERS IN THE LIQUID TUBES ARE CLEAR.

Caution
Ensure that the dispensing and aspiration pumps are not run for longer than a few minutes without liquid or they will be damaged.

Caution
Do not use the instrument to aspirate or dispense any acidic solutions as this could damage the instrument.

WARNING
WASTE BOTTLE - FILLING LEVEL
MAKE SURE THAT THE LIQUID LEVEL OF THE WASTE BOTTLE IS ALWAYS KEPT BELOW THE MAXIMUM LEVEL INDICATED ON THE BOTTLE TO AVOID POTENTIAL OVERFLOW. AS THE CONTENTS OF WASTE BOTTLE ARE POTENTIALLY INFECTIOUS, WEAR PROTECTIVE CLOTHING (GLOVES, LAB COAT AND SAFETY GLASSES) WHEN EMPTYING / HANDLING A WASTE BOTTLE. FOLLOW LOCAL STANDARD OPERATING PROCEDURES ON HOW TO TREAT POTENTIALLY INFECTIOUS MATERIAL FOR DISPOSAL.

Priming is performed to fill the liquid system of the HydroFlex Washer with liquid and to remove all air from the tubes. A priming step must also be performed when switching between buffers.

If different wash buffers are used in a wash program, the instrument performs a prime step automatically.

If the instrument will be left to stand for a longer time, priming must be performed to remove all liquid from the system. For this purpose, remove all tubes from the liquid bottles.
3. General

Priming can be performed by selecting **Prime** in the **Instrument** menu or by clicking the **Prime** button. The following dialog box appears:

![Prime dialog box]

In the **Channel** area select the **Channel** to be primed (1 – 4) and then adjust the prime **Time** (between 5 and 99 seconds) or the volume (15 – 820 ml).

The lowest time and volume to fill the liquid system completely are 10 seconds or 30 ml.

Click **Start** to start the prime procedure.

Click **Stop** to abort the procedure. When the prime procedure has ended, the **Prime** dialog box close automatically.

**Note**

*If the priming step is not performed properly, this can seriously influence wash results.*

3.17 Rinsing

Rinsing is performed to flush the liquid system and to prevent needle blockages. The rinsing procedure should be performed, if the instrument is left to stand or is switched off at the end of operation.

The two rinsing modes are:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Day</strong></td>
<td>Use if the instrument will be left to stand for a short time. When <strong>Day</strong> is selected, a <strong>Time</strong> can also be selected (in seconds). <strong>Rinse day</strong> can be performed with the liquid already in use.</td>
</tr>
<tr>
<td><strong>Night</strong></td>
<td>For thorough rinsing and if the instrument will be left to stand for a longer time. When <strong>Night</strong> is selected the <strong>Time</strong> cannot be set. <strong>Rinse Night</strong> must be performed with distilled water only.</td>
</tr>
</tbody>
</table>

To perform a rinse procedure, select **Rinse** from the **Instrument** menu or click the **Rinse** button and the following dialog box appears:
3. General

Select a Channel and a Mode.
Select the duration Time (5 to 99 seconds) or the volume (15 – 820 ml).
Click Start to start the rinse procedure.

Click Stop to abort the procedure. When the rinse procedure has finished, the needles of the manifold will remain in the liquid until the user presses Stop. Click Close to return to the main window during or after the rinse procedure.

CAUTION
Rinsing is the most important daily cleaning procedure for the HydroFlex Washer and is essential to ensure proper wash performance. For details, see the instructions for use for the HydroFlex Washer.

3.18 Empty Prime Tray

Select Empty Prime Tray from the Instrument menu to remove the liquid from the prime tray. The manifold will move to the prime tray and the liquid will be aspirated out of the tray.
3.19 User Administration

There are three types of administrators mentioned in this publication:

The **System Administrator** is responsible for any changes made to the computer’s operating system. System Administrator rights are necessary to install the HydroControl software on the computer.

The **User Administrator** is responsible for adding users and modifying user rights, adding user groups and modifying user group rights, assigning initial passwords, and changing user administration options within the HydroControl software.

The **Hydro_Administrator** is a specific User Rights Group within the HydroControl software. A user who belongs to this group has access to all features of the HydroControl software, except for those related to the user administration. See 3.19.1 User Rights for further information.

**Caution**

It is recommended that anyone who uses the HydroControl software have “normal” user rights on the operating system (and NOT system administrator rights)!

3.19.1 User Rights

There are three different default security levels of user rights, the highest level of which is **Hydro_Administrator**, a user who belongs to this user group (security level) has access to all program functions, except for those related to the user administration. The **Hydro_Application_Specialist** and **Hydro_Operator** security levels are increasingly limited.

**Note**

*HydroControl offers password protection to prevent misuse of the software and restricts access to parts of the software based on user rights.*

Each right can be assigned or withdrawn from a user group by a User Administrator and by default are assigned as stated below. The default set of rights is based on a typical laboratory environment.

**Caution**

User Administrators have the responsibility of making sure that the settings (and any modifications) match the laboratory environment defined by the user SOPs (standard operating procedures) and comply with all national, regional, and local laws.
The following table shows the **User Administrator** rights and default **User** rights:

<table>
<thead>
<tr>
<th>User Rights</th>
<th>Hydro_Operator</th>
<th>Hydro_Application_Specialist</th>
<th>Hydro_Administrator</th>
<th>User Administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Users and Modify User rights</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Add User Groups and Modify User Group rights</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Assign initial passwords</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Change user administration options</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Run programs</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Edit programs</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Save programs</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Download programs</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Sign documents</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Modify signed documents</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Edit plate parameters</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Set instrument parameters</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Edit lists</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

**Note**

It is recommended that the **User Administrator** **NOT** have any **User Rights** on the HydroControl software (i.e. should not belong to any of the user groups: Hydro_Administrator, Hydro_Application_Specialist, Hydro_Operator or any custom defined groups).
3. General

3.19.2 Logging in for the First Time

When HydroControl is started for the first time, a message appears informing that a User Administrator must be created first.

Click OK and the Create Administrator dialog box appears.

Enter a user name, full name, password, confirm the password and click OK to save the settings. At least one User Administrator must be created.

Caution
If the User Administrator password is forgotten, User Administration settings cannot be changed and HydroControl must be completely reinstalled (the software must first be completely uninstalled and then installed again, not installed “over” the already installed software).

Note
*It is recommended that at least two User Administrators are created.*
After clicking **OK**, the **User Administration** dialog box appears:

Users and groups can be added, edited, or deleted and user rights can be defined. Options for login, password, and email can be edited.

The **User Administration** dialog box contains the following elements:

<table>
<thead>
<tr>
<th>Group List</th>
<th>The group list shows all existing groups (user levels).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Group</td>
<td>A new group with corresponding rights can be created.</td>
</tr>
<tr>
<td>Modify Group</td>
<td>Rights of an existing group can be modified</td>
</tr>
<tr>
<td>User List</td>
<td>The user list shows all existing users and which group they are member of.</td>
</tr>
<tr>
<td>Add User</td>
<td>A new user can be created.</td>
</tr>
<tr>
<td>Modify User</td>
<td>Full name, user level (group) or password of an existing user can be changed</td>
</tr>
<tr>
<td>Disable User</td>
<td>A user account can be enabled/disabled.</td>
</tr>
<tr>
<td>Audit Trail</td>
<td>The audit trail shows all modifications of the user administration database (e.g. creation of groups/user, change of rights, change of options, …)</td>
</tr>
<tr>
<td>Options</td>
<td>General login, password or email options can be modified</td>
</tr>
</tbody>
</table>
Initial Password

When a user logs in for the first time, the password must be changed.

After entering the User name and Password and clicking OK, the following message appears:

```
Your initial password is only valid once. You have to change the password!
```

The initial password is only valid once and expires after three days. If the initial password is not used within three days, the password expires and a new password must be assigned by the HydroControl_Administrator, (this does not apply to "Admin", see 2.1 User Administration Quick Start).

The user must enter the old password then the new password. The new password must be confirmed to prevent typing errors.

The new password will expire after a specified period of time, see Password Expiration, page 3-59.

Login

Each time HydroControl starts, the Login dialog box appears:
Enter the **Username** and **Password** and click the green arrow to continue.

The user account will be disabled after the maximum number of consecutive unsuccessful logins has been reached (see Application Locked, page 3-58).

The **Login** dialog box contains the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Name</strong></td>
<td>Enter your <strong>User Name</strong>.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Enter your <strong>Password</strong>.</td>
</tr>
</tbody>
</table>

### 3.19.3 **Add/ Modify Group**

Click **Add Group** or **Modify Group** in the **User Administration** dialog box and the Add/ Modify Group dialog box appears:

The **Add/ Modify Group** dialog box contains the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group Name</strong></td>
<td>A unique group name has to be entered when a new group is created. This name cannot be modified afterwards.</td>
</tr>
<tr>
<td><strong>Rights</strong></td>
<td>The group represents a specific user level and corresponding user rights can be selected.</td>
</tr>
</tbody>
</table>
3. General

3.19.4 Add/Modify User

Click Add User or Modify User in the User Administration dialog box and the Add/Modify User dialog box appears:

The Add/Modify User dialog box contains the following elements:

Identification

- **Administrator check box**: Select this check box to assign this user User Administrator rights.
- **User Name**: A unique user name has to be entered when a new user is created. This name cannot be modified afterwards.
- **Full Name**: Enter the full name of the user. This can be changed later.
- **Password**: Enter the initial password. The password must be changed at next login.

Rights

- **Groups**: Select from one of the existing user groups. The rights associated with that group are assigned to the user.
3.19.5 User Administration Audit Trail

Click Audit Trail in the User Administration dialog box and the User Administration Audit Trail dialog box appears:

The audit trail shows a list of all modifications of the user administration database. Each entry consists of the user (name and full name), date and time of change and what has been changed.

User rights are identified by number. A description of the right as plain text can be obtained by clicking Description of Rights.

The text can be copied to a word processing program for printing.
3.19.6 User Administration Options

Click Options in the User Administration dialog box and the User Administration Options dialog box appears and has the following tabs: Login, Password and Email.

Login Options

![User Administration Options dialog box]

Auto Lock
If the user doesn't use the application for a specified time (1 min - 24 hours), the application is automatically locked and the user has to reenter the password.

Unsuccessful logins
After a number of consecutive unsuccessful logins (1 - 10), the user account is locked and optionally an alert email is sent to the system administrator.

Application Locked

![Application Locked dialog box]

If the application has not been in use for the specified maximum time it will be locked. The password must be entered to unlock the application. See Auto Lock above.
Password Options

Passwords must fulfill minimum requirements. The minimum length of passwords can be set (5 - 99) and passwords can optionally contain numeric digits.

Password Expiration

Passwords expire after a specified interval (1 - 365 days) and must be changed. Passwords cannot be reused. When the password expires, the user will be prompted to enter a new password.

The Old Password has to be entered.

The New Password must comply with the specified password rules and has to be entered twice to prevent typing errors.

Old passwords cannot be reused.
3. General

Email Options

An administrator can be notified in case of potential security attacks (a user account has been locked because a number of unsuccessful logins).

An email can be sent to the entered email address with two possible methods:

- **SMTP server**: the IP address of the SMTP server has to be entered
- **MAPI**: the profile and password of the mail client has to be entered

Click **Test Mail** to send a test mail to verify that the settings are correct.
3.19.7 **User Administration Summary**

A detailed description of all existing users and user groups as plain text can be obtained by clicking **Summary** in the **User Administration** dialog box.

The text can be copied to a word processing program for printing by clicking **Copy to Clipboard**.

3.19.8 **Select Language**

Use the command **Select Language** from the **Tools** menu to change the language of the HydroControl software and the displayed language on the instrument. The software needs to be closed after selecting a new language. Restart the application; HydroFlex needs to be connected again.

3.19.9 **Change User**

Select **Change user** from the **Tools** menu to logout the current user and to login a different user.

In the header of the main window, the name of the current user is displayed in brackets:
3.19.10 About HydroControl

Select About HydroControl... in the Help menu to open the About HydroControl dialog box:

![About HydroControl dialog box]

All software relevant information is shown.

Click OK to close the dialog box.

3.20 Exiting HydroControl

To exit the HydroControl software, select Exit from the File menu or click the close button in the upper right hand corner of the main window.
Index

Numbers refer to pages.

A
About HydroControl.................................3-62
Add final aspirate ...................................3-7
Add/ Modify Group ...................................3-55
Add/ Modify User .....................................3-56
Administrators
  three types of.......................................3-50
Application Locked ..................................3-58
Approval ................................................3-28
Area of Application ................................1-1
Aspirate Step .........................................3-9
Aspirating Modes ....................................3-10
Aspiration Error ......................................2-6
Aspiration Mode
  Crosswise ............................................3-10
  Normal .................................................3-10
Aspiration Positions ................................3-43
Audit Trail
  Program .............................................3-29
Auto Lock .............................................3-58
B
Bottom Position ....................................3-9, 3-11, 3-12
C
Change User ...........................................3-61
Conductance of Some Standard
  Wash Buffers .......................................2-7
Connect an Instrument .............................1-5
Creating and Editing Programs ....................3-6
Custom Position .................................3-9, 3-11, 3-12
Cycle Strip ...........................................3-8
Cycles ...................................................3-8
D
Dispense Error .......................................2-6
Dispense Position ...................................3-43
Dispense Step ........................................3-11
E
Email Options .......................................3-60
Empty Prime Tray ....................................3-49
F
Final Aspirate Strip ................................3-7
G
Group
  Add/ Modify .........................................3-55
H
Hardware Requirements ............................1-1
I
Initial Password ....................................3-54
Installation ..........................................1-2
  under Windows Vista ............................1-3
  under Windows XP .................................1-2
Instrument Options ................................2-5
Instrument Settings ...............................2-3
  Download to Instrument .........................2-4
  Open from File ....................................2-4
  Save to File .......................................2-4
Intended Use ........................................1-1
L
Liquid Level Detection ............................2-7
List
  Audit Trail .........................................3-37
  Creating ............................................3-34
  Downloading .......................................3-36
  Editing ..............................................3-34
  Importing .........................................3-36
  Printing ............................................3-36
  Saving ..............................................3-35
  Signing .............................................3-37
Viewing ...................................................... 3-36
List Management ............................................. 3-33
Lock Application ............................................. 3-58
Logging in for the First Time .............................. 3-52
Login .................................................................. 3-54
Options .................................................................. 3-58
unsuccessful ............................................. 3-58

M
Manufacturer ...................................................... 3
MAPI .................................................................. 3-60
Menu Description ............................................ 3-2

N
Needle Position Diagrams .................................. 3-43

O
Overflow Position ........................................... 3-9, 3-11, 3-12

P
Password
   Expiration .................................................. 3-59
   Initial ......................................................... 3-54
   Options ....................................................... 3-59
   Restrictions ............................................... 3-59
PC Function Error ......................................... 2-6
PC System Error ............................................. 2-6
Plate Definition Files
   Downloading ............................................. 3-46
Plate Parameters
   Editing ....................................................... 3-38
   Saving ....................................................... 3-44
Plate Strip ....................................................... 3-8
Plates
   Locking ...................................................... 3-45
Previous HydroControl Versions ...................... 1-3
Prime Tray
   Emptying ................................................... 3-49
   Priming ..................................................... 3-47
   Print Preview ............................................. 3-31
Printing Programs .......................................... 3-30
Process Control ............................................. 2-5
   Requirements ........................................... 2-6
Program
   Downloading .............................................. 3-23
   Exiting ...................................................... 3-62
   Importing .................................................. 3-21
   Locking ..................................................... 3-25
   Opening ..................................................... 3-22
   Running ..................................................... 3-26
   Saving ....................................................... 3-19
   Stopping .................................................. 3-27
   Uploading .................................................. 3-24
Program Audit Trail ........................................ 3-29
Program Screen Description ............................. 3-1
Program Strip .................................................. 3-7
Programs
   Signing ..................................................... 3-28
Q
Quick Start
   User Administration ..................................... 2-1
R
Requirements
   Hardware ..................................................... 1-1
   System ......................................................... 1-2
   Reset Password .......................................... 3-56
   Review ....................................................... 3-28
   Rinse Procedure
      Day ............................................................ 3-48
      Night ....................................................... 3-48
   Rinse Vacuum Chamber ................................ 3-15
   Rinsing ..................................................... 3-48
S
Sample Program ............................................ 3-16
   Select Language ........................................ 3-61
   Signatures
      Viewing .................................................. 3-28
      Signing Programs .................................... 3-28
      SMTP Server .......................................... 3-60
      Soak Step ............................................... 3-13
      Specifications ........................................ 1-1
   Start Program from the Editor ...................... 3-27
Start Program from the Instrument ...............3-26
Starting Procedure ......................................2-1
Status Bar Description ..................................3-5
Step
  Aspirate ..................................................3-9
  Dispense ...............................................3-11
  Soak ....................................................3-13
  User Prompt ........................................3-13
  Vacuum Filtration ....................................3-14
  Wash ....................................................3-12
Symbols .....................................................4
System Requirements ....................................1-2
T
  Test Mail ..............................................3-60
  Toolbar Description ................................3-4
  Transferring Programs ..............................3-23
U
  Unsuccessful logins ..................................3-58
  User

Add/ Modify .............................................3-56
User Administration ..................................3-50
Audit Trail .............................................3-57
Options ................................................3-58
Quick Start ............................................2-1
Summary ................................................3-61
User Prompt Step .......................................3-13
User Rights ...........................................3-50, 3-51
  Table of default rights ..............................3-51
V
  Vacuum Chamber
    Rinsing ..............................................3-15
  Vacuum Filtration .................................2-5
  Vacuum Filtration Step .............................3-14
  Viewing Signatures .................................3-28
W
  Wash Step ...............................................3-12
Z
  Z-Positions ..........................................3-43